Amlib
SIP2 Manager
Procedures Manual

Version 6.0

Last Updated: 24 February 2014
## CONTENTS

OVERVIEW .............................................................................................................. 6  
SIP2 Server and Service .................................................................................. 8  
  SIP2Server Process ................................................................................... 8  
  Error Handling & Maintenance ................................................................... 9  
AmlibSIP2Service Settings .............................................................................. 11  
Configuration Manager .................................................................................. 13  
  Amlib Systems tab .................................................................................. 13  
  Sip2 Server tab ...................................................................................... 13  
  Logging tab ............................................................................................ 14  
SIP2 Manager after Version 6.0 Upgrade ......................................................... 15  
  External Support Files ............................................................................. 15  
SIP2 Request – Response Stages ..................................................................... 16  
SIP2 Manager ................................................................................................. 17  
  Login Instructions ............................................................................... 17  
Menus .............................................................................................................. 21  
  File Menu ............................................................................................... 21  
    Properties ............................................................................................ 21  
    Exit ................................................................................................... 22  
Instances Menu .............................................................................................. 22  
  Instances ............................................................................................... 22  
  Convert DIY ......................................................................................... 23  
  Enter Licence Code .............................................................................. 23  
Help Menu ..................................................................................................... 23  
  Getting Started Manual ........................................................................ 23  
  Procedure Manual ............................................................................... 23  
  About ................................................................................................ 23  
Main Window ................................................................................................. 25
Create a New Listener ................................................................. 25
Edit a Listener .............................................................................. 27
Delete a Listener .......................................................................... 28
Create a New Instance..................................................................... 29
Copy from an existing Instance ...................................................... 30
Copy from a Vendor ........................................................................ 31
Create a default Instance.............................................................. 34
Edit an Instance ............................................................................ 34
Delete an Instance ........................................................................ 35
Convert DIY .................................................................................. 37
Parameters .................................................................................... 40
  1. General ................................................................................... 40
  2. Source – Obtain Data for Checking .......................................... 40
  3. Target – Contains Values for Checking.................................... 40
Setting Parameters for a New Instance ........................................... 42
Editing Parameters for a Saved Instance ....................................... 46
  Delete a Parameter ........................................................................ 47
  Adding a Parameter ....................................................................... 48
Core Parameters ........................................................................... 49
Source Types and Examples ......................................................... 53
  Action ......................................................................................... 53
  Constant ....................................................................................... 53
  Database ....................................................................................... 54
  Incoming ....................................................................................... 55
  Message ....................................................................................... 56
  Target Types ............................................................................... 57
  Operator ....................................................................................... 57
Edit Messages ................................................................................ 58
OVERVIEW

SIP2 (Standard Interchange Protocol, Version2) provides communication between the Amlib Library system and other SIP2 compliant computer based applications. It provides controlled access to certain information from Amlib (for example details about Patrons or Items) via a TCP/IP connection through a nominated Port

These applications include Self-Service Circulation (DIY) terminals, accessing Ebooks from Online Suppliers, managing Library Internet PC processes such as PC Reservations, electronic resources and other communications. Ebook applications need to verify that a patron has proper borrowing rights before allowing downloads of Ebooks.

Request messages to access information or perform operations are sent via a connection and the Response messages sent in return.

There are three components that comprise the SIP2 module:

1. **SIP2 Server** which runs as a service in Windows.

2. **Configuration Manager** client program enables settings to be made in relation to:
   - **Database** (Database definition, Usernames and Passwords to the Database)
   - **SIP2 Server** settings (Database prefix, Port Number and maximum No of connections)
   - **Logging** settings (Enabling, Log Files and Archive Files)

3. **SIP2 Manager** client program which is used to maintain the SIP2 settings including:
   - Listener
   - Instance settings. These include:
     - Parameters
     - Messages, Message fields and values

A Self Check device is the connection initiator and the SIP2 server is a TCP/IP listener:

- From Amlib Version 6.0, a multi-threaded SIP2 Server is a replacement for the existing Amlib DIY module. There can be multiple listeners using a single instance.

- The multi-threaded server supports multiple TCP/IP connections from SIP2 clients whereas the Version 5.3 and older versions of the Amlib DIY module only supported a single SIP2 client connection.

- Each instance has its own set of messages, message fields and parameters. The parameters are not dependent on SIP2 client vendor types. The new SIP2 Manager is able to be customised to a greater degree than in the previous versions, in relation to customised messages and parameters.

Functionality exists within the SIP2 Manager for the creation, editing or deleting of Listeners, associated Instance parameters, Instance messages and Instance message fields and values.
SIP2 redevelopment includes the reorganisation of existing parameters and addition of new parameters. The new parameters will facilitate vendor independent coding. It is possible to convert existing Amlib DIY parameters to the new SIP2 parameters during the Version 6.0 upgrade or later using the SIP2 Manager.
SIP2 Server and Service

The SIP2 Server is an application that runs as a Windows Service. The service name is AmlibSIP2Service. After installation the service can be started and stopped in the Services area in Windows.

The SIP2 server uses:

- Settings in the AmlibConfig.xml file maintained by the Configuration Manager
- SIP2 Parameters and Message Values stored in the local database and maintained by the SIP2 Manager
- Amlib Circulation Settings and parameters to check Circulation privileges for the borrower. If different Settings are based on Location the system uses the Login Location of the SIP2 Manager to verify the Circulation settings to use

SIP2 Server Process

1. Before the service starts, the amlibconfig.xml is opened, database connectivity is checked and the Amlib database is at least Version 6.0
2. After starting, the server listens on the defined Port Number for incoming TCP/IP connections from SIP2 clients. The maximum number of concurrent connections is defined in the Configuration manager SIP2 Server tab.

3. When an incoming connection occurs from a SIP2 client, the server determines the IP address of the client and performs a DNS lookup to get the Host name. The Client Address column on the SIP2 Listener table is then checked for either the IP or the host name and if found, the SIP2 parameters are loaded for the instance defined.

4. Once connected the server receives SIP2 request messages from the client and using the instance parameters does the required database lookups, processing etc. and returns the appropriate response message. The parameters define how the data for each field in the response message is derived.

Error Handling & Maintenance

- In the event of the IP or the host name not being found, the connection is closed by the server and the error logged.

- While loading the SIP2 parameters for the instance from the database, checks are performed to verify their integrity. If not valid, the connection is closed and the SIP2 parameter errors logged.

- Logging for the service is saved to the amlib.log file in the folder where the AmlibConfig.xml file is located. By default the installers copy this file to the Data directory for the application. This is operating system dependent. For example in Windows XP it is found in Documents and Settings/All Users/Application Data/OCLC/Amlib SIP2 Manager/amlib.log

For Windows 7 and Windows Server 2008 the default is C:\Program Data\OCLC\Amlib SIP2 Server for the Server and C:\Program Data\OCLC\Amlib SIP2 Manager for the manager.

- After a successful connection, logging specific to the Listener is written to a folder below the main application data folder outlined above. The folder name is the IP address or host name configured for the Listener. The log file name is the same ie amlib.log)
• For diagnostic purposes, the service can also be run in a console by double clicking on the exe in the installation folder. The service must be stopped before doing this. When running as a console, no logging occurs as all messages and errors are displayed

• When parameters are changed, the Client Connection(s) using that Instance have to closed and reopened. This will reload the SIP2 parameters and circulation parameters for the instance and no restart of the SIP2 Server service is required
AmlibSIP2Service Settings

Settings for the Service can be altered using the Properties of the Service in Control Panel > Administrative Tools > Services.

Highlight the Service in the list and right click and choose Properties

General TAB

The General TAB contains:

- Service Name – needs to be AmlibSIP2Service
- Service Status
- Path to the SIP2Server application
- Startup Type

Log On

Set to Local System Account
Recovery TAB
Keep as default settings

Dependencies TAB
Keep as default settings
Configuration Manager

The SIP2 server uses settings in the AmlibConfig.xml file maintained by the Amlib Configuration Manager. This file is saved in the Application data folder depending on the operating system. For example in Windows 7, it is saved in ProgramData/OCLC/Amlib SIP2 Server/ AmlibConfig.xml. In XP it is held in Documents and Settings/All Users/Application data/OCLC/Amlib SIP2 Server/AmlibConfig.xml.

The settings are:

Amlib Systems tab
- Amlib Database definition – Database Prefix and Description etc

SIP2 Server tab
- Database Prefix (must be configured in the Amlib Systems tab)
- TCP/IP Port Number for the SIP2 Server to listen for SIP2 Client connections
- Maximum Number of Concurrent connections (thread pool) – Number of connections that you wish to allow at the same time through the port. This will depend on the type of connections – whether they are Self issue devices or Ebook patron verifiers. The setting here should also be equal to or greater than the No of Licences set in the SIP2 Manager
- Changing any of these setting requires a restart of the service

Note: Ensure that there are enough Computer resources (for example Memory) to allow for the No of connections specified – especially if set to a high number
Logging tab

- Debug logging enabled - if enabled all message data is logged. Errors are always logged by default
- Maximum log file size (MBytes)
- Number of archived log files
- Changing any of these setting requires a restart of the service
### SIP2 Manager after Version 6.0 Upgrade

When the program is first run after upgrading to 6.0, it will display a form which populates the Master Message and Message Field tables.

It will also allow optional conversion of existing DIY parameter sets to the new table structure.

After completion there will an entry in the UPDATE_LOG Table in the LIB database for each process. The example below shows the creation of the master messages, conversion of parameter set 1 as a 3M device and parameter set 2 as an Envisionware device.

<table>
<thead>
<tr>
<th>PROCESS_ID</th>
<th>PROCESS_NAME</th>
<th>AMLIB_VERSION</th>
<th>DATE_STARTED</th>
<th>DATE_COMPLETED</th>
<th>STATUS</th>
<th>EXTRA_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>266</td>
<td>DIYParamsToSIP2-MasterMessages</td>
<td>6.0</td>
<td>2011-06-14</td>
<td>2011-06-14</td>
<td>S</td>
<td>NULL</td>
</tr>
<tr>
<td>267</td>
<td>DIYParamsToSIP2-1-3M</td>
<td>6.0</td>
<td>2011-06-14</td>
<td>2011-06-14</td>
<td>S</td>
<td>NULL</td>
</tr>
<tr>
<td>268</td>
<td>DIYParamsToSIP2-2-EnvisionWare</td>
<td>6.0</td>
<td>2011-06-14</td>
<td>2011-06-14</td>
<td>S</td>
<td>NULL</td>
</tr>
</tbody>
</table>

The parameters are stored in tables in the Local database – the tables and their created using the Amlib 6.0 Changes.sql upgrade script.

The SIP2 Server uses settings in the AmlibConfig.xml file maintained by the Amlib Configuration Manager.

The SIP2 Subsystem must be defined before any activity can be done. Existing Amlib DIY configurations can be converted for the updated SIP2 Facility. See separate Notes on Conversion.

### External Support Files

To facilitate the conversion process and setting up of specific vendors, external xml files contain default data. These files are:

- **DIYParametersConversion.xml** – Holds parameter data from the existing DIY parameters relevant to SIP2 plus additional fields required for the new setup.

- **VendorsConversion.xml** – Holds SIP2 message and field defaults for the currently supported vendors in DIY – 3M, EnvisionWare, STILogitrack, TalkingTech, SmartLibrary, Overdrive and Wheelers.

- **DIYVendorDIYType.xml** – Defines which parameters in the DIYParametersConversion.xml are relevant to the vendors in VendorsConversion.xml.
SIP2 Request - Response Stages

Request from Client

*Example: Checkout Request*

Response message found for Master Message Partner

*Example: Checkout Response*

Parameters to Check — Parameter needs to be present in the Field Values of the Message. Checked for True to continue based on parameters defined in Parameter Source/Target) *Example: Borrower Fine Limit < $5.00*

Parameters to Process — If parameter present in the Values process as defined

*Example: Renew Overdue Item*

SIP2 Fields built for Response - gets values as defined for Instance

*Example: Title Identifier*

Response back to Client
SIP2 Manager

Login Instructions

1. Launch the Amlib SIP2 Manager client – the Amlib Login with Connection Details window will display:

   ![Amlib Login Screen](image)

   - Amlib User Name: STAFF
   - Password: ********
   - Database: Live

2. Enter a valid Amlib User Name and Password (not case-sensitive)

3. Select a Database – this should be the same Live database you use for Amlib

4. Click the OK button – the Please select a location window will display:

   ![Please select a location Screen](image)

   - Code: C
     - Description: Council library
   - Code: LD/Y
     - Description: Wombat Self Check only
   - Code: LIB
     - Description: Wombat Library

5. Choose a login location and click the OK button (by default, the Location setup for your Username in the Amlib Installation settings will be highlighted).
Note: A different Location can be used for gathering Statistics for the Self Check Issues. This is set up on the Listeners Window – in the Location for Stats section.

6. The first time the login occurs, The Amlib SIP2 Manager dialogue box will display. It will be necessary to enter a code for the Number of Licences the site is configured to use. If you do not have the code it will be needed before the setting up of the Manager can go any further. Contact Amlib Support to obtain the relevant code.

7. Click OK

8. The Enter Licence Code dialogue box will display.

9. Enter the licence code and press OK

10. The Amlib SIP2 Manager confirmation box will appear showing the No of licences applied.

   **Ensure that the Maximum Number of Concurrent connections configured in the Configuration Manager is equal to or greater than the No of Licences**
11. Click **OK**

12. The **SIP2 Manager** box displays to give the information about initialising the SIP2 system before use. It is possible to Convert existing DIY parameters to initialise the system.

13. Click **OK** to continue

14. The Create SIP2 Master Message and/or convert DIY Parameters Dialogue box will display

15. Click the Convert from DIY parameters if a conversion is required from the parameters set in DIY (suggested). See Convert DIY
16. At the finish, a message will display

![Processing completed successfully]

**Note:** The licences are set up as a range:

- 1 user
- 2-5 users
- 6-10 users
- 11-20 users
- 21- Unlimited
Menus

File Menu

Properties

Displays the Paths for the Getting Started Manual and Procedure Manuals.

Please Note: It is possible to customise both the Getting Started guide and the full Procedures Manual – see: Appendix A: Modifying & Linking Your Own Manual in the Amlib SIP2 Manager Client

Last Updated: 24 February 2014

Version: 6.0
A full Help system is available within the Amlib SIP2 Manager client. From the menu, select Help > Help – the Help guide will display.

Context sensitive Help is available on each screen by clicking the F1 Function key on the screen Window on which Help is required.

In addition, a Getting Started guide and the full Procedures Manual (both in PDF) can be accessed from the Help menu.

Exit

Closes the Amlib SIP2 Manager

Note: The SIP2 Manager can also be closed by clicking the X on the top far right Corner of the SIP2 Manager Window

Instances Menu

Instances

Displays the Instances currently defined.

From this Window it is possible to select buttons for the following:

- **New**: Create a New Instance
- **Edit**: Edit the Instance to change the description of an Existing Instance
- **Edit Messages**: All the Messages will display for the existing Instance. It is then possible to Add, Edit or Delete Messages – See more information in separate section
• **Edit Parameters**: All the Messages will display for the existing Instance. It is then possible to Add, Edit or Delete Parameters - See more information for [Edit Parameters](#)

• **Delete**: [Delete Instances](#) to remove them from the SIP2 Manager. Instances cannot be deleted if they are being used by a Listener

**Convert DIY**

Create SIP2 Master Messages and, if selected, [Convert DIY Parameters](#) to SIP2 Parameters. This Process will create a New Instance which can then be further modified if required

**Enter Licence Code**

Allows the entry a new code to update the Number of Licences the site is configured to use.

**Help Menu**

**Getting Started Manual**
Displays the Getting Started Manual from the path as shown in the Properties

**Procedure Manual**
Displays the Procedures Manual from the path as shown in the Properties

**Help**
Displays the full SIP2 Help Contents

**About**
Displays the Version number and Copyright details
Main Window

The SIP2 Main window displays any configured Listeners. A Listener defines an incoming TCP/IP connection to the SIP2 Server, the instance it will use for the SIP2 messages, an Amlib logon to load circulation parameters and a location for statistics. from SIP2 devices via TCP/IP connections. It is possible to have different Listeners connect to a single Instance. When defining the Listener an IP Address or Host Name can be used.

Create a New Listener

1. Click the New Button - the New Button will be disabled if the number of Listeners configured is equal to the No of Licences.

2. Select the Instance from the Drop-down list of Instances (If no Instances display, these need to be set up first from the Instances Menu – See Create a New Instance).

3. Enter the Client Address of the Self Check device which must be either the IP or Host Name. This is used to load the SIP2 parameters of the instance after an incoming connection is received.
4. If the details listed are the IP address ensure the Checkbox for **IP Address** is ticked.

5. Select the Amlib Login **Username** from the Drop-down list of valid Usernames. The Username is used to get the Login Location and Circulation Parameters etc.

6. Enter the **Location** for where the **Circulation statistics** will be posted to for reporting.

This could be the same as the Login Location or a different Location if separate statistics is required for just the Self Check device. A new Location could be created in Amlib and used just for the collection of statistics for the Device. This is most relevant for Returns type devices.
7. Click **Apply** to save the settings or **Cancel Edit** to discontinue with the editing

**Edit a Listener**

To change any details for the Listener

1. **Highlight** the *Listener* on the Listeners Table (from the Main Window of the Amlib Sip2Manager)

2. Click the **Edit** Button

3. The entries for each field displays

4. Change the **Instance** if required

5. Change the **Client Address – IP Address or Host Name** if required

6. Change the **Location for Statistics** for the collection of Statistics if required

7. Click **Apply** to save the settings or **Cancel Edit** to discontinue with the editing
Delete a Listener

1. **Highlight** the *Listener* on the Listeners Table (from the Main Window of the Amlib SIP2 Manager)

2. **Click** the *Delete* Button

3. A confirmation message will display

4. **Select** *Yes* to delete the Instance or *No* to cancel out of the deletion process
Create a New Instance

It is possible to create a New Instance as the result of a Conversion of AmLib DIY parameters (see further Notes on this process – Convert DIY). The following options outline how to create a New Instance if the DIY AmLib facility has not been used previously OR the existing parameters are not being converted

1. From the SIP2 Manager Window, select Instances from the Instances Menu. If already defined, the Instances display in the top window.

To create a new Instance, select New

It is possible to

- Copy from an existing Instance (if already defined)
- Copy from a Vendor
- Create a default Instance
Copy from an existing Instance

This will copy ALL the Parameters, Messages and Message Field values from one instance already defined to another instance that can be renamed. This option will remain grey if there are no instances defined on the Instance Window

1. Select New from the Instances Window
2. Ensure Copy from an existing Instance is the radio button selected
3. Select the Instance to copy from the Drop-down box
4. Click OK
5. Highlight the newly created Instance on the Table
6. Select **Edit**

7. Give the New Instance a new **Description**

8. Select **Apply**

9. It is then possible to Edit Messages or Edit Parameters as required

**Copy from a Vendor**

This will ensure necessary Parameters, Messages and Message Field values relevant to the Vendor will be made available as parameters to use in the Parameter table. It will be necessary to add some Target Values to some of the Parameters where the Target Values do not exist.

1. Select **New** from the Instances Window

2. Ensure **Copy from a Vendor** is the radio button selected

3. Select the **Vendor to copy** from the Drop-down box
4. Click **OK**

5. The **New Instance from Vendor** Window will display with the relevant Parameters for that particular vendor displayed.

6. There will be some Default parameters ticked. These will be required by the Vendor and can’t be unselected either manually or by using Unselect All.

7. Not all parameters need to be selected but for those that are selected must have Target Values. Some of these Values will need to be entered where the Target Value is blank. If left blank, the Instance will be able to be saved but a message will be displayed noting that the configuration will need to be completed manually.

8. To add or edit a **Target Value** for a Parameter, double click the line or select Edit (see details below), set to required values and click **Apply**. Generally it is the **Database values** that will...
be needed for selection using the Special button – displaying the selection choices for the Source Value selected. See below more details on Parameters.

9. Tick the parameters to be selected for the new Instance from the Include column displaying first in the top Window.

**Note:**

- If most parameters are to be included select the Select All button and revise to uncheck any not to be included.
- To uncheck most of the parameters there is an Unselect All button that may be useful.

10. When complete, select Create Instance button. Any Parameters selected but without a Value will display where value will need to be defined.

11. It is suggested, that if this message is displayed, that No is selected and the Target Values be entered for the Missing Values.

12. Once the Target Values are set for those chosen for the Instance, the creation should be successful.
Create a default Instance

Generally, Copy from an existing Instance OR Copy from a Vendor would be selected.

It is possible to Create a default Instance from scratch, but this would NOT be advised.

Once selected, every Parameter and Message would have to be entered manually. If this is required please contact Amlib Support for advice.

Edit an Instance

To change any the Description of the Instance

1. Highlight the Instance on the Instances Table (from the Instance Menu)
2. Click the **Edit** Button

3. The description for the Instance displays

4. Change the **Description** as required

5. Click **Apply** to save the settings or **Cancel Edit** to discontinue with the editing

**Delete an Instance**

1. **Highlight** the **Instance** on the Instances Table (from Menu Instances)
2. Click the **Delete** Button. If it is being used by a Listener, a message will display

![Delete Button Message]

3. If the Instance is no longer being used by a Listener, the deletion can take place. A **confirmation message** will display

![Confirmation Message]

4. Select **Yes** to confirm or **No** to cancel the Deletion
**Convert DIY**

This facility is displayed after the Version 6.0 Update for conversion. It can be accessed after the Upgrade if other Parameter sets are also to be converted.

From the Instance Menu, select **Convert DIY**

![Image of Convert DIY window]

This **Conversion process** will create the **SIP2 Master Messages** for the selected Vendor. It can **convert** the current settings from the **DIY parameter set** within Amlib Supervisor, Library Menu, DIY Params. It will create a new Instance as a result of the process. As there can be several sets of parameters, it is possible to select the Set Number of the Parameter Set to convert.

1. Select **Convert from DIY Parameters** if the existing Amlib Parameters are to be converted across to the SIP2 Manager
2. Select the Vendor
3. To **view** the Vendors supported, click on the Drop-down arrow. A listing will display:
   - 3M
   - TALKING Tech
   - Logitrack
   - EnvisionWare
   - Smart Library
   - Overdrive
   - Wheelers

![Image of Convert DIY window with vendor selection]

---

Last Updated: 24 February 2014

Version: 6.0
4. Select the Number for the DIY Parameters Set to be converted. For example, Set 1

5. Select the Run button to begin the Conversion

6. When complete (it will only take a few minutes) click the Exit button

7. A new Instance will be created as a result of the Conversion and will list in the Instances Table

8. An Entry is inserted in the **UPDATE_LOG** table for each run – for example ‘DIYParamsToSIP2-3M’

All files (log and xml) are located in the same folder as the executable. If the DIY conversion is rerun for the same Parameter Set a Verify Run Selections window will display where confirmation of a rerun can be given with a Yes response, or cancel the rerun with a No response

![Verify Run Selections](image)

**Note:** Some of the parameters used in Amlib DIY will NOT be converted because they are not used within SIP2 or that they are using the underlying Circulation parameters

<table>
<thead>
<tr>
<th>Amlib DIY Parameter Not Converted</th>
<th>Borrower / Stockitem</th>
<th>Amlib DIY No</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>➢ Max on loan</td>
<td>B</td>
<td>1</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Borrower reregister on expiry</td>
<td>B</td>
<td>5</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Log off password</td>
<td>B</td>
<td>8</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Inactivity timeout</td>
<td>B</td>
<td>9</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>3m Offline</td>
<td>B</td>
<td>15</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib version</td>
<td>B</td>
<td>16</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Library Name</td>
<td>B</td>
<td>18</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Terminal Location</td>
<td>B</td>
<td>19</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib Main Image</td>
<td>B</td>
<td>23</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib Borr Image</td>
<td>B</td>
<td>24</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib Item Image</td>
<td>B</td>
<td>25</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Event Description</td>
<td>Component Type</td>
<td>Code</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>----------------</td>
<td>------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Amlib Allow Print onloan</td>
<td>B</td>
<td>26</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Wand Barcode Desc</td>
<td>B</td>
<td>27</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib Allow Print new items</td>
<td>B</td>
<td>28</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Borrower Button Text</td>
<td>B</td>
<td>29</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Allow renewals in Amlib</td>
<td>B</td>
<td>31</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib Invalid borrower barcode</td>
<td>B</td>
<td>32</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>If Proceed = Y: Check for item charge on return</td>
<td>S</td>
<td>5</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>and cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop issue on charge</td>
<td>S</td>
<td>6</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>No loan allowed</td>
<td>S</td>
<td>7</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>No renewal allowed</td>
<td>S</td>
<td>8</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Renewal limit exceeded</td>
<td>S</td>
<td>9</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Item not for loan</td>
<td>S</td>
<td>10</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Renew Overdue Item</td>
<td>S</td>
<td>11</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Max Items Reached</td>
<td>S</td>
<td>12</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Exceeded Form Limit</td>
<td>S</td>
<td>13</td>
<td>Apply circulation parameters</td>
</tr>
<tr>
<td>Default loan period</td>
<td>S</td>
<td>17</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib - Item button text</td>
<td>S</td>
<td>18</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Allow returns in Amlib</td>
<td>S</td>
<td>19</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Amlib - Print return items list</td>
<td>S</td>
<td>20</td>
<td>Not Applicable for SIP2</td>
</tr>
<tr>
<td>Return reserved item</td>
<td>S</td>
<td>21</td>
<td>Not Applicable for SIP2</td>
</tr>
</tbody>
</table>
Parameters

The Parameters Window is reached by creating a New Instance from a Vendor or by the Edit Parameters button from the Instances Window

When creating or editing each parameter of an Instance, there 3 main levels

1. General
   - Description – Description of the Parameter
   - Message – Message that will appear in the DIY interface
   - Type – Item, Patron or System

2. Source - Obtain Data for Checking
   - Source Type : Action, Constant, Database, Incoming, Message
   - Null Value : Not Allowed/Allowed
   - Source Value - Depends on the Source Type chosen

3. Target - Contains Values for Checking...
   - Target Type: Database, DateTimeValue, Decimal Value, IntegerValue, StringList, StringValue
   - Operator : Equal, Not Equal, In, Not In, Greater, Less etc. Restricted by the Target Type
   - Target Value: Entry depends on the Target Type
   - Special – to give a listing of Database Values for inclusion e.g. Borrower Types used so that they can be selected for the parameter or DateNow (for current date)

Note: It is possible to create a New Instance based on the Instance created previously e.g. for different branches
SIP2 Manager – Setting up Instances, Parameters and Messages
Setting Parameters for a New Instance

Once the Instance has been created from a Vendor the default Parameters will display.

It will be necessary to choose your own Values where there are currently No Target Values.

Select a parameter and Double click or press Edit. The fields will display in the lower section.

Note: The **Borrower exists on database** (for a check of Invalid Borrower) and **Item exists on database** (for a check of Invalid Item) are special parameters that **MUST** be used and cannot be edited except for the Message response.

1. The default Description, Message and Type of the parameter will display

   - **Description** – Description of the Parameter – it is **not** recommended that this be edited. However it is allowed as a new Parameter may need to be entered if advised by a Vendor or if a correction to a description is necessary.

   - **Message** – Message that will appear in the DIY interface – this is the message that the users of the DIY will see if an Issue is blocked for some reason. This can be edited by the site to make the messages more meaningful.

   - **Type** – Item, Patron or System (for Source Type of Messages only) – whether the Data will come from the Item, Patron or System Tables of the database.

2. Check the **Source** details. Generally it will be the Database Type parameters where the values are to be set.

   - **Type** – Action, Constant, Database, Incoming or Message.
• **Null Value** – Decide whether a null value (empty field) is allowed. Select NotAllowed/Allowed from the Drop-down options (*Note*: Allowing a null value is rare. Borrower Group is an example where a null value is recommended)

• **Value** – Select the Value as required. This will be dependent on the Instance Type (Patron, Item or System) as well as the Source Type chosen previously
  
  o If the Source Type is Database, the choices in the Database Table and sub Table are further restricted by the **Target Type** which is selected
  
  o For example if the Instance Type is Patron, the Source Type is Database and the Source Value is chosen from the Borrower Table, the Target Type endeavours to set to a suitable Type automatically
  
  o *Note*: All the values possible within the selected Table will display – not all are relevant but select only the Value needed for the Source of the Parameter. Some of these Values will never be selected but remain in the list for future use if required

If changed to Amount Owing, the Target Type will alter

3. **Check the Target values**

  • **Type** – Database, Date Time Value, Decimal Value, Integer Values, String List, String Value.

  • **Operator** – Select the Operator appropriate. For example In, Not In etc.
• Value – Select the Database Table and sub Table if relevant

4. If the Source Value is a Database Table, select relevant codes from the Special button. Tick the codes and OK

5. When complete, select **Apply** or **Cancel Edit**

6. On Apply, the relevant data will display in the Target Value column in the top section

7. It is necessary to decide which Parameters will be available for the Instance. These can be used for the Parameters to Check, Screen or Print messages fields etc in the Instance messages. It is possible to use the **Select All** button to include all parameters and then go through and deselect any that will not be needed. Two parameters (Borrower – Exists on database and Item – Exists on Database) cannot be deselected as are used by the majority of messages.
**Note**: The Parameters that are NOT Selected do not need to have their Target Values created

8. Click **OK** to exit and save the parameters set

9. **Hint**: If another parameter is to be chosen and the current Parameter is not to be saved, then ensure the **Cancel Edit** button is chosen prior to selecting the next Parameter to Edit. This will not be allowed until the current Parameter is either applied or cancelled
Editing Parameters for a Saved Instance

Once the Instance has been created and saved, it is possible to alter the Parameters if required

1. From the Instances Window, highlight the relevant Instance and select **Edit Parameters**

2. The Parameters Window will display

3. Select a parameter and **Double click** or press **Edit**. The fields will display in the lower section
4. The default Description, Message and Type of the parameter will display as described above.

5. After each parameter has been set click **Apply**.

6. To exit the screen click the **OK** button.

**Delete a Parameter**

1. Highlight the Parameter.

2. Click the Delete button.

3. A check will be made of the Instance Messages, Values and Fields. If the parameter is being used a message will display listing the Message Number and details of the Messages being referenced:

   ![Message List](image)

   **Amthib SIP 2 Manager**

   The Parameter cannot be deleted as it is referenced by the Instance Message(s) and Field(s) below:
   
   10 - MagneticMedia
   12 - ParametersToCheck
   12 - MagneticMedia
   30 - ParametersToCheck
   30 - MagneticMedia

   ![Confirmation Message](image)

   4. If the Parameter is not referenced it is removed from the Parameter list. A confirmation message will display:
Adding a Parameter

1. Click the **New** button
2. Enter the Description, Message and Type of the parameter
3. Enter the Source Fields
   - Type – choose from the Drop-down options
   - Null Value – Allowed/Disallowed
   - Value – Select the Value from the Drop-down options – Depends on the Source Type. In some instances a Database Table is selected and a Database
4. Enter the **Target** values
   - Type
   - Operator
   - Value and sub Value if needed
5. When complete, select **Apply** or **Cancel Edit**
6. Click OK to leave the Window
### Core Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Comments/Message display if Fail occurs on the Parameter......</th>
<th>Source/Target Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ADULT</strong> Borrower Type(s)</td>
<td>Identify Borrower Type for any Adult – used for populating the information for the Response message rather than parameter to check. Enter code/s for Adult patrons</td>
<td>Source: Database Value: Borrower Table: TypeCode Target: StringList Operator: In Value: xxx,xxx from Special list of codes</td>
</tr>
<tr>
<td><strong>CHILD</strong> Borrower Type(s)</td>
<td>Identify Borrower Type for any Child - used for populating the information for the Response message rather than parameter to check. Enter code/s for Junior patrons</td>
<td>Source: Database Value: Borrower Table: TypeCode Target: StringList Operator: In Value: xxx,xxx from Special list of codes</td>
</tr>
<tr>
<td>Exists on Database</td>
<td>Hardcoded: Must be included as a parameter and cannot be edited, deleted or unselected</td>
<td>Source: Incoming Operator: Exists Target Type: Database</td>
</tr>
<tr>
<td><strong>Fine Limit</strong></td>
<td>If a Borrower has Money owing - how much the value will be before the Self Check is halted: Allow the issue where the Amount owing is less that 5.00</td>
<td>Source: Database Value: Borrower Table: Amountowing Target: Less Value: x.xx</td>
</tr>
<tr>
<td><strong>Group</strong> (Used to set Internet Access)</td>
<td>Not a Member of a Permitted Group Code (some sites use the Borrower Group code to indicate whether Internet is allowed or No Internet)</td>
<td>Source: Database Value: Borrower Null Value: Allowed Value: Borrower Table: BorrowerGroupCode Target: StringList Operator: NotIN Value: xx,xx from Special</td>
</tr>
<tr>
<td><strong>Memo Count</strong></td>
<td>If a Borrower has a Memo</td>
<td>Source: Action Value: Borrower MemoCount Target: IntegerValue Operator: Less Value: 1</td>
</tr>
<tr>
<td><strong>Overdues Count</strong></td>
<td>If a Borrower has Overdue Items</td>
<td>Source: Action Value: Borrower OverduesCount</td>
</tr>
</tbody>
</table>
### 3M,E,L, T

**Message:** Loan. See Library Staff

| Target | IntegerValue | Operator | Less | Value: 1 |

### Owing not equal to 0 E,L,S, T

**Message:** Borrower has Money owing

| Source | Database | Value: Borrower | Table: Amountowing | Target: DecimalValue | Operator: Equal | Value: 0.00 |

### PIN required 3M, E,L,S,T

**Message:** Borrower needs a Personal Identification Number in addition to a Barcode

| Source | Incoming | Value: Patron Password |
| Source | Database | Value: Borrower |
| Target | Database | Equal |
| Field: PIN |

### Registration expired 3M,E,L,S,T

**Message:** Check Patron Registration Date

| Source | Database | Value: Borrower |
| Table: RegistrationDate | Target: DateTimeValue |
| Operator: Greater |
| Value: DateNow |

### Item

#### Alert 3M,E,L, S,T

**Message:** An Alert is placed on the Stockitem

| Source | Database | Value: Stockitem |
| Table: UserAlert | Target: StringValue |
| Operator: NotEqual |
| Value: Y |

#### Allow Cancel of overdue Charge on Return/Checkin E,L,S

**Message:** Allow cancel of Overdue Charge on Return

| Note: This parameter only needs to exist on this Table. Leave as a Constant and will be checked at the time if chosen as a Parameter to Check |

| Source | Constant | Value: Y |
| Target | StringValue |
| Operator: Equal |
| Value: Y |

#### Allow Issue/Checkout/Renew when Item On Loan to another borrower E,L, S,T

**Message:** If an item is showing as being on loan already.

| Note: This parameter only needs to exist on this Table. Leave as a Constant and will be checked at the time if chosen as a Parameter to Check |

<p>| Source | Constant | Value: Y |
| Target | StringValue |
| Operator: Equal |
| Value: Y |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Source</th>
<th>Value</th>
<th>Target</th>
<th>Target Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Issue/Checkout/Renew when Item Reserved by another borrower</td>
<td>If an item is reserved already. <strong>Note</strong>: This parameter only needs to exist on this Table. Leave as a Constant and will be checked at the time if chosen as a Parameter to Check. <strong>Message</strong>: This item may not be issued. Please take it to the Information Desk.</td>
<td>Constant</td>
<td>Y</td>
<td>StringValue</td>
<td></td>
</tr>
<tr>
<td>Allow Renew of Overdue Item</td>
<td>If an item is Overdue allow renew? <strong>Note</strong>: This parameter only needs to exist on this Table. Leave as a Constant and will be checked at the time if chosen as a Parameter to Check. <strong>Message</strong>: This item is overdue and may not be renewed.</td>
<td>Constant</td>
<td>Y</td>
<td>StringValue</td>
<td></td>
</tr>
<tr>
<td>Exists on Database All Vendors</td>
<td>Hardcoded: Must be included as a parameter and cannot be edited, deleted or unselected <strong>Message</strong>: Invalid Item.</td>
<td>Incoming</td>
<td></td>
<td></td>
<td>Database</td>
</tr>
<tr>
<td>Magnetic Media 3M,E,L,S</td>
<td>Magnetic Media that should not go through the self check <strong>Message</strong>: These are sensitive items and cannot be lent via DIY.</td>
<td>Database</td>
<td>Stockitem</td>
<td>StringList</td>
<td></td>
</tr>
<tr>
<td>Magnetic Media 3M,E,L,S</td>
<td>Magnetic Media that can go through the self check <strong>Message</strong>: These are sensitive items and can be lent via DIY.</td>
<td>Database</td>
<td>Stockitem</td>
<td>StringList</td>
<td></td>
</tr>
<tr>
<td>Memo Count 3M,E,L,T,S</td>
<td>If an Item has a Memo <strong>Message</strong>: This item may not be Issue. Please take it to the Information Desk.</td>
<td>Action</td>
<td>Item MemoCount</td>
<td>IntegerValue</td>
<td></td>
</tr>
<tr>
<td>Not to be removed 3M,E,L,S</td>
<td>Items that should not be removed from the Library. Can’t go through the Desensitise process <strong>Message</strong>: These may be issued but not.</td>
<td>Database</td>
<td>Stockitem</td>
<td>StringList</td>
<td></td>
</tr>
<tr>
<td>Institution ID</td>
<td><strong>Message</strong>: Name of Library</td>
<td>Source: Message</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------</td>
<td>----------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M,E,L,S,T</td>
<td></td>
<td>Target: StringValue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printer message</td>
<td><strong>Message for Library</strong></td>
<td>Source: Message</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M,E,L,S,T</td>
<td>To display for Reports etc.</td>
<td>Target: StringValue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Message</td>
<td><strong>Message for Screen</strong></td>
<td>Source: Message</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M,E,L,S,T</td>
<td>To display on the screen as a Default unless an alternative message displays due to an alert message etc.</td>
<td>Target: StringValue</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3M = 3M, E = Envisionware, L = Logitrack, S = Smart Library, T = Talking Tech
Source Types and Examples

Action

Predefined actions that may be used in Parameters or Message fields

Valid Actions

- Borrower Available Hold Count
- Borrower Issues Count
- BorrowerMemoCount
- BorrowerOutstanding
- BorrowerOverduesCount
- BorrowerUnavailableHoldCount
- ItemCirculationStatus
- ItemMemoCount
- ItemMediaType
- ItemProperties
- CheckinAlertTypeLocation
- Checkin3MChuteAlertTypeLocation
- BorrowerMemoText
- ItemMemoText
- BorrowerMaxOverdueDays

Example

When an Item Memo Count is present, then a message will display “Please call at the Information Desk as we have a message for you” as the result will be False for the Source/Target calculation – so message will display

Constant

Value that is fixed and not changed via the Database – Text values

Example

Item Charge cancelled (Source and Target value of Y as a String Value)
Database

The value is derived from a table and column in the Amlib Database

Valid Table entries:

- Borrower
- Stockitem
- Items On Loan
- Reservation
- Financial Transactions

Once the Table is selected, the columns for that table are available for selection in the second value dropdown.

Note – the first Value is always a Table Name and then the second Value is always a column for from that Table. For example, Borrower in the First column, Borrower Type in the second value column

Example

The Special button displays a Target List which allows for the Values to be selected.
Incoming

The Value is derived from a field in the Request Message from Vendor. The fields available are dependent on the message type as defined in the SIP2 protocol. This may be a better option than querying the Database to find the Value, as it is fast and efficient.

Example of valid Incoming Field Names

- Fee Amount
- Language
- Patron Identifier
- Patron Password
- Item Identifier

Example: Borrower PIN required
Message

The Value is text only and no Target value needs to be defined.

Fields within messages where these may be used are

- Screen Message – used as a defaults unless an Error Message displays
- Print message – for slip printers depending on the SIP2 client
- Institution ID: Library Name
Target Types

If the Source Type = Database then the available Target Types are derived from column definition in the Amib database.

- Database – derived from the Database values
- DateTime Value – Date and Time
- Decimal Value – Numbers showing decimal places
- Integer Values – Number Values
- String List – List of Alpha/Numeric codes
- String Value - Value which may be Alpha/Numeric

Operator

Operator used when evaluating Source and Target Values.

The values available for selection are dependent on the Source and Target Type.

- Exists (special case for Borrower, Item Lookup)
- Equal
- Not Equal
- Greater
- Less
- Greater Than or Equal
- Less Than or Equal
- In
- Not In
Edit Messages

The Instance Messages window will display. Apart from one, Messages are linked as pairs, with a Request and a Response together. For example a Checkin Request is linked to a Checkin Response.

Block Patron is an exception to this and is a separate Request Message with no linked Response

This Window displays:

1. Number of the Message – this is the Standard No for SIP2 and cannot be altered
2. Description of the Message
3. Message Type:
   - Request – Cannot be edited
   - Response – Can be edited

Note: When clicking on a Request line, the Edit button remains grey because only Response messages can be edited

4. Click on any Response Message to be edited. The Edit button will display
5. For example, click on Hold response
6. The Message fields relevant to the Response will display

7. Fields are different Types
   - **System**: Defined from a predefined process. Cannot be edited
   - **Database**: Value is a Database Lookup (Table, column/s & formatting)
   - **Parameter**: Value is dependent on Parameter(s) check (Boolean Fields only)
   - **Incoming**: Value is from an Incoming Field in the request message
   - **Action**: Value is from a predefined action
   - **Constant**: Value does not change

**Adding a New Message to the Instance**

New Fields can be added if the parameter allows. This depends on the Vendor chosen and the Instances Messages already defined

1. From the Instance Messages Window select the **Add** Button

2. The Add Message – Instance window will display where any Master Messages available to add will be listed
3. Click the Include checkbox if to be included. Master Message to add or Select All to tick All Messages

4. Select OK

5. The selected Message will now list in the Instance Message Table. Note: The accompanying Response Message will also be added. For example, if Renew (Message 29) is added, the linked Response (Message 30 – Renew Response) will also be added

**Edit Fields**

Where Fields exist for Instance messages, it is possible to Edit the actual Fields of the Message

1. **Highlight** the message and select **Edit Fields**

---

Last Updated: 24 February 2014

Version: 6.0
2. The Message Fields Window will display

![Message Fields Window](image)

3. It is possible to alter either Add or Edit the Type or Values

4. To Add a Message Type
   a. Select **Add**. Any Master Field not yet applied to the Instance will display. Select any Message Fields to add by clicking into the Include Checkbox
      - If most parameters are to be included select the **Select All** button and revise to uncheck any not to be included
      - To uncheck most of the parameters there is an **Unselect All** button that may be useful
      - The Fields are listed with the Field Description and the Message Field Type
**Note:** Some of the Response Messages may already be included. This is because they are required Fields in the Standards

b. It is possible to alter the Message Type by selecting from the Drop-down options. This will depend on the Message and guidance sort from the 3M Standard Interchange Protocol. The Message Type will be one of the following:

- Action
- Constant
- Database
- Incoming
- Parameter
- System (**Note:** These cannot be altered to another Type)
c. The Message Field will appear in the list

To Edit Values
There should be at least one value for each Message Field (except System Fields which do not require a Value)

1. Highlight the Message Field
2. Select **Edit Values** from the Message Fields Window

3. The elements of the Response Packet will display

4. New elements can be added by clicking on the **New** Button. This will depend on the Vendor and what is required to be contained in the Response packets back to the Vendor. It will also depend on what Type of Field is identified.

5. If a Database Field, the first value on the Field Value table is the **Table name** from which to derive the data. The second value **must** always be a column name for the table. The Table names include:
   
   a. Borrower
   b. Financial Transactions
   c. Items on Loan
   d. Reservation
   e. Stockitem

![Field Values window](image-url)
6. The other Values that can be selected depend on the Table Name. If this first selection Value is edited and changed, then the other Values are no longer Valid and will require reselection.

7. Once the Table name has been selected, click the Special Button to choose the other Column Values. These can be selected from a Drop-down box to be selected and moved to the Column

   a. Select the Value from the Drop-down box

   b. Click the Column button to move it to the Selection box

   c. Text or Spaces can be added. Enter the relevant Text in the right hand Text Field and select the Text button to move it to the Selection box. Note: Spaces can be added here to make it easier to read and is indicated as a <space> in the Selection box

   d. Click OK to save the Table Column Values or click Cancel to exit
8. If Cancel is selected a **confirmation** will display

9. Select **Yes** to Save the changes, **No** to exit without Saving and **Cancel** to remain on the Window for further editing

10. Message Values can be moved up and down the list by using the Up and Down buttons with the exception of a Database Type field where the first value is always the Table and the second must be a valid column name.
   
   a. Highlight the Value line to move
   
   b. Click on the Up or Down button as required
   
   c. Click OK when the Order is fixed correctly

**Delete Instance Message**

From the Instance Messages Window highlight the Message line to delete and select the Delete Button

If the Request line is deleted the Response part of the pair will also be deleted. The Response part cannot be deleted separately

**Warning:** Deleting Instance Messages would *not normally* be necessary unless advised from the Vendor that the Request packets are no longer sent

A confirmation message will be displayed. Select Yes to delete and No to cancel
Remove Message Number 9 from the Instance Messages?

[Yes] [No]
ParametersToCheck

ParametersToCheck is a special field in response messages except Status and is used by the Amlib SIP2 Server to perform validation and depending on the result, set field values in the response message or stop processes such as Checkout.

The ParametersToCheck field for a message contains values which are parameters that have been defined for the instance. The evaluation of the Source and Target value for the parameters return a true or false result. All parameter results are combined using Boolean And to produce an overall true or false result.

If the overall result is false then the process such as Checkout will not proceed or the patron status will be set to invalid in response to a patron information request.

Parameter Source and Target values can be modified or removed from or added to the ParametersToCheck field to alter the validation rules for the Instance Response message.

To Edit or Add the Values:

1. From the Instances menu, select Instances. Highlight the relevant Instance.
2. Select Edit Messages. The Instances Messages Window displays.
3. Highlight the relevant Message. For example Number 12 Checkout Response.
4. Select Edit Fields.
5. The Message Fields Window will display.
6. Scroll to ParametersToCheck.
7. Click Edit Values.
8. The Field Values Window will display

9. Highlight the **ParametersToCheck**

10. **Note**: Some Values are needed by the system and cannot be removed. The Delete button will remain Grey for these Values. For example, Borrower – Exists on Database, Item – Exists on Database

   To remove a Value from being checked, highlight and select **Delete**
11. To **Add** a **New** value to be checked, select the New button

12. Select the Value from the Drop down box

13. As the Fields are combined as a Boolean set, **And** is the only Type available

14. Click Apply to add the Value. Click Cancel Edit if it is not to be applied
ParametersToProcess

ParametersToProcess may be used to allow certain processes to proceed if a defined situation occurs.

There are four available ParametersToProcess values for use with Checkin, Checkout or Renew:

- **IssueItemOnLoan** (Issue an Item even if it shows to be on loan at the time of the Self Check issue. It returns to item as it would in the normal Issues window). Valid for Message 12 (Checkout response)

- **IssueItemOnReserve** (Issue an Item even if it is Reserved for another borrower at the time of the Self Check issue). Valid for Message 12 (Checkout response), Message 30 (Renew Response), Message 66 (Renew All Response)

- **RenewOverdueItem** (Allow Renew even though the Item is Overdue for the borrower performing the Self Check issue) If the Parameter exists in the list, it is included in the checking. If the Parameter is not present in the list, it is NOT included in the checking. Valid for Message 12 (Checkout response), Message 30 (Renew Response), Message 66 (Renew All Response)

- **ReturnRemoveOverdueCharge** (Return an Item and remove the Overdue charge that may apply). Valid for Message 10 (Checkin response)

For example, if the Stockitem shows that it is already On Loan, then if the ParametersToProcess includes IssueItemOnLoan, then proceed with the loan (acts like an override).

If the decision to **not allow** any Stockitem currently on loan to be issued via the Self Check system, then **remove** the parameter from the ParametersToProcess by the Delete button.

1. From the Instances menu, select Instances. Highlight the relevant Instance
2. Select **Edit Messages**. The **Instances Messages** Window displays
3. Highlight the relevant Message. For example Number 12 Checkout Response
4. Select **Edit Fields**

5. The **Message Fields Window** will display

6. Scroll to **ParametersToProcess**

7. Click **Edit Values**

8. The **Field Values Window** will display
9. To remove a Value from being checked, highlight and select **Delete**

10. To **Add** a New value to be checked, select the **New** button

11. Select the Value from the Drop down box. Disregard the Type.

12. Click **Apply** to add the Value. Click **Cancel Edit** if it is not to be applied
Parameters - Messages Interaction

In Version 5.3 and previous Versions the Amlib DIY parameter indicated the Message, whether to Proceed and the Parameter Number

In the new SIP2 Manager, a parameter exists on the Parameter table for the Instance, as well as being used in the special message field as a ParametersToCheck. Each Parameter on the Table could be used various times within the Master Messages. For example used for CheckOut Response, Hold Response, Patron Status Response etc.

Example: Memo count

Borrower Memo Count

Previous DIY Value: 2

Appears on the Parameter table

Parameter Type: Patron
Source Type: Action
Target Type: Integer Value
Messages: Can be Included as a Checkout Response (Message 12) – Parameters to Check
Also available in other Master Messages from the Value Drop-down for Parameters to Check
SIP2 Manager – Setting up Instances, Parameters and Messages

SPECIAL SCREEN MESSAGES

It is possible to edit a System Message to include text – for example, to have a Reservation alert first if applicable before a System Message. Another example would be to include a Borrower Memo when a Borrower looks at their details.

Applying a Reservation Message Parameter

1. Go to Instances Menu in Sip2 Manager
2. Highlight the Instance
3. Click Edit Parameters
4. The Instance Parameters window will display
5. Click New
6. Enter the Description of Reservation Message
7. Enter the Message to be viewed – for example, Reserved at
8. Enter the Message Type from the Drop-down list – this will be System
9. Enter the Source Type – this will be Database
10. Enter the Source Value for the Table – choose Reservation from the Drop-down list
11. Also enter the **Source Value** for the **Column** – choose **CollectLocation** from the Drop-down list

12. Click **Apply**

**Applying a Reservation Message**

1. Go to **Instances Menu** in Sip2 Manager

2. **Highlight** the Instance

3. Click **Edit Message**

4. The Instance Messages window will display

5. **Highlight** the Response appropriate – for example, Checkin Response

6. Select **Edit Fields**

7. **Highlight** **Screen Message**

8. Select **Edit Values**

9. Enter **New**

10. Select the **Reservation message** from the Drop-down list of Values

![Field Values](image)

11. Leave the **Type** as **Or**

12. Select **Apply**
13. The **Reservation Message** will display under the System – Screen Message

14. Highlight the Reservation message line

15. Click **Up** to move it above the System Screen Message

16. Click **OK**

17. When a Reservation is due for Collection a Reservation Message will display

**Applying a Borrower Memo Parameter**

13. Go to **Instances Menu** in SIP2 Manager

14. Highlight the Instance

15. Click **Edit Parameters**

16. The Instance Parameters window will display

17. Click **New**

18. Enter the **Description** of **Borrower Memo**
19. Enter the **Message** to be viewed – for example, **Memo** :

20. Enter the **Message Type** from the Drop-down list – this will be **System**

21. Enter the **Source Type** – this will be **Action**

22. Enter the **Source Value** for the **Action** – choose **BorrowerMemo Text** from the Drop-down list

23. Click **Apply**

**Applying a Borrower Memo Message**

1. Go to **Instances Menu** in SIP2 Manager

2. **Highlight** the Instance

3. **Click** **Edit Message**

4. The Instance Messages window will display

5. **Highlight** the Response appropriate – for example, Patron Information Response
6. Select **Edit Fields**

7. **Highlight** **Screen Message**

8. Select **Edit Values**

9. Enter **New**

10. Select the **Borrower Memo** from the Drop-down list of Values

11. Leave the **Type** as **Or**

12. Select **Apply**
13. The Borrower Memo will display under the System – Screen Message

14. Highlight the Reservation message line

15. Click Up to move it above the System Screen Message

16. Click OK

17. If the borrower has a memo, the Screen message field will contain the text for the memo. Otherwise the System Default Screen Message text will be present
Media Types

Media Type is a field used for statistical purposes by the Envisionware Onestop product.

In Version 6.0 Media Type is part of the Form definitions.

The Media Type is included in the Response messages with the value of the Field derived from the Form code being processed:

- 10 – Checkin response
- 12 – Checkout response
- 18 – Item information response
- 30 – Renew response

The valid values for the Media Type field are:

- 000 - Other
- 001 - Book
- 002 - Magazine
- 003 - Bound Journal
- 004 - Audio Tape
- 005 - Video Tape
006 - CD/CDROM
007 - Diskette
008 - Book with Diskette
009 - Book with CD
010 - Book with Audio Tape
Appendix A: Customise PDF help Files

Location of Original Help Files

The original text version of the Help > Getting Started and Help > Procedure Manual can be located in the AmlibSIP2/HelpDocs folder on the Amlib server. These files may be customised to incorporate information specific to your institution and then linked to the Amlib SIP2 Manager client.

The two files are:

- SIP2GettingStarted.doc
- SIP2ProcedureManual.doc

Once modified they can be saved in PDF format

The altered file should be saved with a new name (for example: SIP2GETSTAT.DOC to avoid being overwritten during an upgrade.

Link to an Updated File

1. Launch the Amlib SIP2 Manager client
2. The initial screen shows the current processes
3. From the menu, select File > Properties – a blank Properties screen will display
4. The File Paths to the Getting Started guide and the Procedure Manual will both be showing.
5. To link to an updated guide:
   a. Click on the button next to the file you want to alter
   b. Navigate to the location of the customised file
   c. Select the file and click on the Open button – the File Path to the document will be updated
   d. Click on OK button when complete
Appendix B: SIP/SIP2 Messages and Fields Supported by Vendor Type

3M Self Check

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td>• 63 – Patron Information</td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 35 – End Patron Session</td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td>• 17 – Item Information</td>
</tr>
<tr>
<td>• 01 – Block Patron</td>
<td>• 29 – Renew</td>
</tr>
<tr>
<td>• 11 – Checkout</td>
<td>• 65 – Renew All</td>
</tr>
<tr>
<td>• 09 – Checkin</td>
<td>• 37 – Fee Paid</td>
</tr>
</tbody>
</table>

*SIP2 Extensions are used in the response packet:

- **CV** field – Alert type
  
The following alerts are checked for:

<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 01</td>
<td>• hold for this library</td>
</tr>
<tr>
<td>• 02</td>
<td>• hold for other branch</td>
</tr>
<tr>
<td>• 04</td>
<td>• send to other branch</td>
</tr>
</tbody>
</table>

- **CT** field – Destination Location
- **CY** Field – Hold Patron ID
- **DA** Field – Hold Patron Name
TalkingTech iTiva

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td>• 63 – Patron Information</td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 35 – End Patron Session</td>
</tr>
<tr>
<td>• 01 – Block Patron</td>
<td>• 17 – Item Information</td>
</tr>
<tr>
<td></td>
<td>• 29 – Renew</td>
</tr>
<tr>
<td></td>
<td>• 65 – Renew All</td>
</tr>
<tr>
<td></td>
<td>• 15 – Hold</td>
</tr>
</tbody>
</table>

STi LogiTrack RFID

**No packet checksum is generated for this device.**

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td>• 63 – Patron Information</td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td></td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td></td>
</tr>
<tr>
<td>• 11 – Checkout</td>
<td></td>
</tr>
<tr>
<td>• 09 – Checkin</td>
<td></td>
</tr>
</tbody>
</table>

EnvisionWare

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td>• 1^63 – Patron Information</td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 35 – End Patron Session</td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td>• 17 – Item Information</td>
</tr>
<tr>
<td>• 01 – Block Patron</td>
<td>• 29 – Renew</td>
</tr>
<tr>
<td>• 11 – Checkout</td>
<td>• 65 – Renew All</td>
</tr>
<tr>
<td>• 2^09 – Checkin</td>
<td>• 37 – Fee Paid</td>
</tr>
</tbody>
</table>

^Special fields or formatting are used in the response packet:

Non standard fields:

- **ZY** field – Using Borrower type (either ADULT or CHILD or no ZY field)
- **PA** field - Internet access using Borrower group (I = Internet OK / NI = No Internet)
Non standard format in fields:

- **AT** field – Overdue items:
  
  - Item Barcode <space> Item due date <space> Issuing location <space> $0.00 <space> Item title

- **AV** field – Fine/Fees:
  
  - Transaction id <space> $Fine amount <space> Fine type <space> Item title/comments

- **AS** field – Available Hold items:
  
  - Item Barcode <space> Reserve location <space> Reserve Date <space> $0.00 <space> b <space> Item title

- **CD** field – Unavailable Hold items:
  
  - Item Barcode <space> Reserve location <space> Reserve Date <space> $0.00 <space> b <space> Item title

2. **SIP2** Extensions are used in the response packet:

- **CV** Field – Alert type

  The following alerts are checked for:

<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>hold for this library</td>
</tr>
<tr>
<td>02</td>
<td>hold for other branch</td>
</tr>
<tr>
<td>04</td>
<td>send to other branch</td>
</tr>
</tbody>
</table>

- **CT** field – Destination Location

- **CY** Field – Hold Patron ID

- **DA** Field – Hold Patron Name

**OverDrive**

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>97 – Request ACS Resend</td>
<td>63 – Patron Information</td>
</tr>
<tr>
<td>99 – SC Status</td>
<td></td>
</tr>
<tr>
<td>23 – Patron Status Request</td>
<td></td>
</tr>
</tbody>
</table>

**Wheelers**
SIP2 Manager – Setting up Instances, Parameters and Messages

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td></td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 163 – Patron Information</td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td></td>
</tr>
</tbody>
</table>

Special fields are used in the response packet:

Non standard fields:

- PD field – Borrower Date of Birth in yyyyymmdd format

SmartLibrary

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td></td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 63 – Patron Information</td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td>• 35 – End Patron Session</td>
</tr>
<tr>
<td>• 01 – Block Patron</td>
<td>• 117 – Item Information</td>
</tr>
<tr>
<td>• 11 – Checkout</td>
<td>• 29 – Renew</td>
</tr>
<tr>
<td>• 209 – Checkin</td>
<td>• 65 – Renew All</td>
</tr>
</tbody>
</table>

Special fields or formatting are used in the response packet:

Non standard fields:

- CR field – Item collection code
- CS field – Item Call Number

The fields are separated by a ^ character

SIP2 Extensions are used in the response packet:

- CR field – Item collection code
- CS field – Item Call Number
- CT field – Destination Location
- CV Field – Alert type

The following alerts are checked for:
<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>02</td>
<td>hold for this library</td>
</tr>
<tr>
<td>03</td>
<td>hold for other branch</td>
</tr>
</tbody>
</table>

- **CY** Field – Hold Patron ID
- **DA** Field – Hold Patron Name
### Appendix C: Master Message Parameters

#### Request and Response Message types supported

<table>
<thead>
<tr>
<th>Request</th>
<th>No of Partner Response</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Block Patron</td>
<td>24</td>
<td>Patron Status Response</td>
</tr>
<tr>
<td>09 Checkin</td>
<td>10</td>
<td>Checkin Response</td>
</tr>
<tr>
<td>11 Checkout</td>
<td>12</td>
<td>Checkout Response</td>
</tr>
<tr>
<td>15 Hold Cancel</td>
<td>16</td>
<td>Hold Response</td>
</tr>
<tr>
<td>17 Item Information</td>
<td>18</td>
<td>Item Information Response</td>
</tr>
<tr>
<td>23 Patron Status Request</td>
<td>24</td>
<td>Patron Status Response</td>
</tr>
<tr>
<td>29 Renew</td>
<td>30</td>
<td>Renew Response</td>
</tr>
<tr>
<td>35 End Patron Session</td>
<td>36</td>
<td>End Session Response</td>
</tr>
<tr>
<td>37 Fee Paid</td>
<td>38</td>
<td>Fee Paid Response</td>
</tr>
<tr>
<td>63 Patron Information</td>
<td>64</td>
<td>Patron Information Response</td>
</tr>
<tr>
<td>65 Renew All</td>
<td>66</td>
<td>Renew All Response</td>
</tr>
<tr>
<td>99 SC Status</td>
<td>98</td>
<td>A C S Response</td>
</tr>
</tbody>
</table>
Appendix D: Flowcharts: Overviews of Manager, Parameters, Messages

- SIP2 Manager - Overview
  - Listeners
    - Instance/s
      - Messages
        - Fields
        - Values
      - Parameters
        - Source Values
        - Target Values
Messages - Overview

Parameters - Overview

Message Fields

Field Values

Request → Response

Add new Master Message/s

Edit Fields

Add new Master Message/s

Edit Type

Action
Constant
Database
Incoming
Parameter
System

Edit Values

Values depend on the Field

Parameters to Process
If the Value is included in the list, then proceed

Parameters to Check
If exists in the list make a check of underlying parameter values associated with the Response
Glossary

For more detailed explanations of the Master Messages please refer to the 3M Standard Interchange Protocol, Version 2.00

ACS: Automated Circulation Software which is Amlib in this context

Action: Predefined valid action that may be defined that has relevance to the Vendor. Used for Source values of Parameters. Examples include Borrower Issues Count, Item Memo Count etc.

Block Patron: Request Message that the patron card be blocked by Amlib due to a reason raised at the Self Check device due to tampering or because a card was left in the device. Request Message 01 – Response Partner is 24 Blocked Status Response

Configuration Manager: Contains the database settings and a SIP2 Server Tab with Server settings

Checkout: Request Message (Message11) used by the Self Check device to process an Issue (Loan) of an Item. Respond with Checkout Response (Message12). This Request has a series of Amlib Parameters to Check and Parameters to Process as well as undergoing Amlib Circulation Checks (for example Loan Privileges)

Checkin: Request Message (Message9) used by the Self Check device to process a Return of an Item. Respond with Checkin Response (Request Message10). This Request has a series of Amlib Parameters to Check and Parameters to Process as well as undergoing Amlib Circulation Checks (for example Loan Privileges)

Constant: A uniform Value entered as Text that will remain the same under different circumstances. Used for Source values of Parameters. This Value is fixed

Database: Fields and Values are derived from the Tables and Columns within the Database structure. At least 2 String entry Values are needed – the actual Table name and a Column field

Fields: Standard SIP2 Message Fields contain Values that make up a Response Packet. These are defined within each Master Message and contain information such as Fee Amount, RenewalOK. They are sent as a Field ID within the packet - For example AA (Patron Identifier). The can be of varying types – Action, Constant, Database, Incoming, Parameter, System. There are also Fields that contain Value for Parameters to Check and Parameters to Process that impact on whether the Response will be actually sent or stopped

Incoming: Source Type is determined by the Request packet and contains Field Names relevant to the Vendor in the Message being received.

Instance: Set of Parameters that can be customised by a site to suit the connection activity between Amlib and a Vendor for SIP2

IntegerValue: Number Value

Instance Messages: SIP2 communication includes a Request as well as a Response, so consists of Message pairs. Each Message pair is independent of previously sent or future Message pairs. Each Message has a standard number e.g. Checkout Response is Message 12
**Instance Message Fields**: The Fields and associated Values that make up a Message. For example, a Checkout Response, Message 12 may be made up of several Message Fields which contains Values e.g. Renewal OK, Fee Amount etc.

**Listener**: The Network computer that will receive messages from SIP2 devices via TCP/IP connections. It is possible to have different Listeners for each Instance. When defining the Listener an IP Address or Host Name can be used.

**Master Messages**: The entire set of Request and Response Standard Messages and Standard Numbers supported for SIP2. These Messages contain Master fields. See [Master Messages](#).

**Multi threaded SIP2**: Supports multiple TCP/IP connections on a defined port from SIP2 Clients.

**Packet Format**: Messages from and to the Client to Amlib. Each message packet starts with a command identifier, followed by field values and ending in a carriage return. Generally contains ASCII characters.

**Port Number**: Defined Port Number which is used by the Server to “listen’ for the incoming TCP/IP connections from SIP2 clients.

**Request**: A coded message (Message type 0) requesting information from Amlib. This can take many forms and usually results in a Response that is paired. For example a Checkout request is received and a Checkout Response packet is returned.

**Response**: A coded message (Message type 1) responding to a Request and results in information being sent back. These can take many forms and usually results in a Response that is paired. For example a Checkout request is received and a Checkout Response packet is returned.

**SIP2**: Standard Interchange Protocol provides communication between the Amlib Library system and other computer based applications via TCP/IP connections on defined Ports usually in range 6000 and above.

**SIP2 Server**: Runs the SIP2 Service (AmlibSIP2Service) in Windows.

**SIP2 Manager**: Client program which maintains the SIP2 Parameters used by the Server.

**Source**: Source Values within the Parameters are combined with Target Values, are used with an Operator to return a True/False response. The Source Values will depend on the Type of Parameter and the column names available etc. Often it is easiest to decide on the Target Type required to limit the Source Values appropriate. For example find the Borrower Columns available in the Source Values for IntegerValues Targets.

**StringValue**: An Alpha Numeric (Letter and/or Number) Value which can be picked up from the Database. For example Y or RM12.

**StringList**: A List of Code Values that can be selected from the Special button (once selected it displays a list of codes to be selected by clicking the Check box of the relevant codes). One or more codes can be selected.
**Target**: Target Values within the Parameters are combined with Source Values, are used with an Operator to return a True/False response.

**Values**: Information contained for the Fields. The Values are defined for the Parameters as Target Values and form the basis of the response field.

**Clarifications**

- When setting the Target Values for the *Borrower Fine Limit*, ensure that the **Borrower Table / AmountOwing** is used. The Outstanding Amount from the FinancialTransactions Table refers to individual Transactions and *not* the total owing.

- **StartLocationCode** in the **Borrower Table** is the Location Joined (Location code where the Borrower joined the Library) – would not be used much for SIP2 but available in case
## Appendix E: DIY Parameters applicable to SIP2

### Borrower Type Parameters

<table>
<thead>
<tr>
<th>Type</th>
<th>No.</th>
<th>Parameter Settings – No in brackets indicates Database value</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>2</td>
<td>Action(4) BorrowerMemoCount(3) Less(4) IntegerValue(1) 1</td>
<td>Please call at the Information Desk as we have a message for you</td>
<td>Borrower has memo</td>
</tr>
<tr>
<td>B</td>
<td>3</td>
<td>Action(4) BorrowerOverduesCount (2) Less(4) IntegerValue(1) 1</td>
<td>You have overdue items on Loan. Please call at the Information Desk</td>
<td>Borrower has overdues</td>
</tr>
<tr>
<td>B</td>
<td>4</td>
<td>Database(0) Borrower(0) AmountOwing Equal(1) DecimalValue(2) 0.00 (see B30)</td>
<td>You have an outstanding account. Please call at the Information Desk</td>
<td>Borrower owes money</td>
</tr>
<tr>
<td>B</td>
<td>6</td>
<td>Database(0) Borrower(0) RegistrationDate Greater(3) DateTimeValue (4)</td>
<td>Your registration has expired. Please call at the Information Desk</td>
<td>Borrower has expired</td>
</tr>
<tr>
<td>Type</td>
<td>No.</td>
<td>Parameter Settings</td>
<td>Message</td>
<td>Comment</td>
</tr>
<tr>
<td>------</td>
<td>-----</td>
<td>--------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>B</td>
<td>7</td>
<td>Incoming(1) Field=PatronPassword(AD) Equal(1) Database(0) Borrower(0) PIN</td>
<td>Please enter your Pin number</td>
<td>Borrower Pin No. Required if Proceed = Y</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>If Group Codes in message Database(0) Borrower(0) BorrowerGroupCode Null source value=Allowed(1) If Proceed Y In(7) Else NotIn(8) StringList(0) (Group codes from message)</td>
<td></td>
<td>Borrower group(s) with preceding hyphen If Proceed =Y List of permitted groups If Proceed =N List of prohibited groups</td>
</tr>
<tr>
<td>B</td>
<td>14</td>
<td>If Proceed Y Include message 01 Block Patron request</td>
<td>Update borrower status if instructed by device</td>
<td>3m Update status Process 01 Block Patron request</td>
</tr>
<tr>
<td>B S</td>
<td>17</td>
<td>Message</td>
<td>Amlib Public Library</td>
<td>Institution Id</td>
</tr>
<tr>
<td>B S</td>
<td>20</td>
<td>Message</td>
<td>Welcome to the Library</td>
<td>3m Screen message</td>
</tr>
<tr>
<td>B S</td>
<td>21</td>
<td>Message</td>
<td>Happy Christmas</td>
<td>3m Print message</td>
</tr>
<tr>
<td>B</td>
<td>30</td>
<td>Database(0) Borrower(0) AmountOwing Less(4) DecimalValue(2) (value from message) (see B4)</td>
<td>3100 Your Account has exceeded the allowed limit</td>
<td>Borrower fine limit - The 1st 4 digits are limit in cents</td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>33</td>
<td>If Type Codes in message Database(0) Borrower(0) TypeCode In(7) StringList(0) (Type codes from message)</td>
<td></td>
<td>Borrower type(s) with preceding hyphen which are classed as ADULT</td>
</tr>
<tr>
<td>B</td>
<td>34</td>
<td>If Type Codes in message Database(0) Borrower(0) TypeCode In(7) StringList(0) (Type codes from message)</td>
<td></td>
<td>Borrower type(s) with preceding hyphen which are classed as CHILD</td>
</tr>
<tr>
<td>S</td>
<td>1</td>
<td>If Proceed Y ParametersToProcess IssueItemOnLoan</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
<td>Item already on loan</td>
</tr>
<tr>
<td>S</td>
<td>2</td>
<td>Action(4) ItemMemoCount(6) Less(4) IntegerValue(1) 1</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
<td>item has memo</td>
</tr>
<tr>
<td>S</td>
<td>3</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>STK_OPER_ALERT</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not Equal S (Y)</td>
<td>item has alert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>4</td>
<td>Database(0) Stockitem UserAlert NotEqual(2) StringValue(3) Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This item may not be issued. Please take it to the Information Desk</td>
<td>item has alien reserve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>5</td>
<td>If Proceed Y ParametersToProcess ReturnRemoveOverdueCharge</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item charge cancelled</td>
<td>If PROCEED = Y Check for item charge on return and cancel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>7</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You may not borrow this type of Item</td>
<td>No loan allowed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>8</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You may not renew this type of item</td>
<td>No renewal allowed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>9</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You have renewed this too often already</td>
<td>Renewal limit exceeded</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>10</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This item may not be borrowed</td>
<td>Item not for loan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>11</td>
<td>If Proceed Y ParametersToProcess RenewOverdueItem</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item is overdue and may not be renewed</td>
<td>Renew Overdue Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>12</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You have too many items on loan already</td>
<td>Max Items Reached</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>13</td>
<td>No conversion – uses Circulation Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You have too many items of that type on loan</td>
<td>Exceeded Form Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>14</td>
<td>If Form Codes in message</td>
<td>Magnetic media</td>
<td></td>
</tr>
</tbody>
</table>

Last Updated: 24 February 2014

Version: 6.0
<table>
<thead>
<tr>
<th>Database(0)</th>
<th>Item form code(s) with preceding hyphen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockitem</td>
<td>If Proceed =Y List of permitted form codes</td>
</tr>
<tr>
<td>FormCode</td>
<td>If Proceed =N List of prohibited form codes</td>
</tr>
<tr>
<td>If Proceed Y In(7)</td>
<td></td>
</tr>
<tr>
<td>Else</td>
<td></td>
</tr>
<tr>
<td>NotIn(8)</td>
<td></td>
</tr>
<tr>
<td>StringList(0)</td>
<td></td>
</tr>
<tr>
<td>(Form codes from message)</td>
<td></td>
</tr>
<tr>
<td>Magnetic media</td>
<td>Item form code(s) with preceding hyphen</td>
</tr>
<tr>
<td>Item form code(s) with preceding hyphen</td>
<td>If Proceed =Y List of permitted form codes</td>
</tr>
<tr>
<td>Item form code(s) with preceding hyphen</td>
<td>If Proceed =N List of prohibited form codes</td>
</tr>
<tr>
<td>Items not to be removed from library eg Reference</td>
<td>Item form code(s) with preceding hyphen</td>
</tr>
<tr>
<td>The returned item is on reserve to another borrower</td>
<td>Return reserved item</td>
</tr>
<tr>
<td>No conversion – uses vendor conversion default Checkin message</td>
<td>CY field-Borrower barcode</td>
</tr>
<tr>
<td>DA field: Borrower Name</td>
<td>CV field: Alert type</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Alert</td>
<td></td>
</tr>
</tbody>
</table>